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License
The WaveMail software may only be used if licensed by Schuemperlin
Engineering AG. A license is valid for 1 WaveMail station (and several local
users on that station).
Non-licensed use of the software is illegal.

Copyright
The WaveMail software and accompanying documents are owned by
Schuemperlin Engineering AG, Switzerland. The software may only be
copied for archiving purposes.
Copyright (c) 1997-2004, Schuemperlin Engineering AG. All rights reserved.
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1. Overview
WaveMail is an e-mail software which is optimized for efficient messaging
over radio modems, Inmarsat telephones, Thuraya or Iridium phones as well
as ordinary telephone modems. WaveMail also allows the use of TCP/IP-
connections.

WaveMail lets you create, send/receive and manage messages and binary
attachments. Messages can be sent or received to/from other WaveMail
stations or to/from the Internet (if the WaveNet Internet Gateway has been
installed in your WaveMail network).
Swiss-PTC Pactor modems, Packet Radio modems, satellite phones
(Inmarsat, Thuraya, Iridium), any AT-compatible telephone modems or
TCP/IP-links can be used to exchange messages between WaveMail
stations. Messages can be addressed to several recipients. WaveMail takes
care of automatic forwarding.
Every WaveMail station is identified by a Station-ID. The Station-ID is used to
address messages and to establish links between stations. Messages can be
addressed to a station or to a particular person (user) on a station.

WaveMail uses very efficient methods for message transfers (automatic
compression of messages, little protocol-overhead, resume of interrupted
message transfers) and therefore allows efficient messaging over
inexpensive radio links. This saves money and time.

Telephone Modem

InmarsatSwiss-PTC Swiss-PTC

Packet Radio

Packet Radio

HF-Radio
HF-Radio

HF-Radio

VHF/UHF-Radio

Satellite

Swiss-PTC

Example of a small WaveMail network
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2. First Steps

2.1. System Requirements
PC with Windows 95 /  Windows 98 / Windows NT 4.0 / Windows-2000 /
Windows-XP.

2.2. Installation
1. Insert the WaveMail Diskette or CD into the drive.
2. Start the WM_SETUP_n_n.EXE installation program and follow

instructions (n_n is the version, e.g. wm_setup_2_0.exe).
3. After the installation is complete you can start WaveMail.

2.3. Start WaveMail
- Doubleclick on WaveMail icon on the desktop
       or
- use the START button in Windows then go to Programs, then WaveMail,

then click on WaveMail.

2.4. Help
Use function key F1 to get context sensitive help information in WaveMail.
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2.5. Setup

2.5.1. Before you begin

Before you setup a station, you should

!
- select a Station-ID for that station. The Station-ID identifies a

station within a WaveMail network. It is used to address
messages and to establish connections. As an example you may
use the name or abbreviation of the city where your station is
operating (max 11 characters).  Valid characters are: 'A' - 'Z' , '0' -
'9' , and '_'. The Station-ID is not case sensitive.

- obtain the License Code (software protection) from the supplier
of WaveMail. You have to communicate the Station-ID to obtain
the License Code, because the License Code is related to the
Station-ID.

2.5.2. Minimum Setup

 Select Station Setup from the Setup menu to
- enter the Station-ID
- enter the License Code
- add a Modem

 Select Network Setup from the Setup menu to
- define at least one Link to another WaveMail station

2.5.3. More about Setup

F The section  'Step-by-Step Setup Examples' in chapter 'Advanced
Setup' will help you to understand how to setup WaveMail.

More detailed informations about Setup can be found in chapter
'Advanced Setup'.
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3. Routine Operation

3.1. POSTMASTER and Normal Users
The POSTMASTER is a user with special rights. Only the postmaster can
change the Station Setup and Network Setup. If no users are defined on a
WaveMail station, the only user is automatically the postmaster.

3.2. Start
Connect the modem(s) and switch it/them on before starting WaveMail
After you start WaveMail, the program will initialize the modem(s). This
operation may take several seconds for every modem.
After that, you will either see the main screen or the 'Username and
Password' dialog. In the latter case you have to enter your username and
password to get access to your messages. ( The  'Username and Password'
dialog will only appear if a POSTMASTER or several users have been
defined on a station.)

3.3. WaveMail Screen
The WaveMail screen is divided into the following areas:

            Folder selection                Toolbar               Message list

             Modem status                             Message preview
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3.4. Creating a new Message

1. Create new message
Click on the 'New' button of the toolbar to open a new message.

A new message appears.

2. Select recipient(s)

Click on the To button in the
new message to open the
addressbook.

Select recipients from the
addresslist on the left and use
the To and Cc buttons to copy
the recipients addresses to the
'To' and 'Cc' list on the right.
Then click on OK to return to
your new message. The
selected addresses will be
inserted into the 'To' and 'Cc'
lines. For every recipient you
will see the name and the e-
mail address in angle brackets

Use the Modify Addressbook button if the addressbook does not yet contain
the desired recipient(s).

You can also enter the recipients address(es) directly into the 'To' or 'Cc'
lines of the new message.
Multiple addresses must be separated by a semicolon ';'.
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3. Enter subject and text

Enter text and subject.

You can also import text from a
plain text file. Use 'Import Text
from File' from the 'Edit' menu
or use the  button. (TO:, CC: or
SUBJECT: headers are copied to the
respective fields of the new message if
found in the first lines of the imported text.)

      subject    text       request confirmation

You can optionally request a delivery confirmation. You will then be notified,
after the message has been delivered to the recipient(s). Messages
addressed to the Internet may not return a delivery notification because this
depends on the e-mail software and settings on the recipients PC.
If a message can not be delivered (e.g. bad address) you will get a non-
delivery notification independent of whether you have requested a delivery
confirmation or not.

4. Add Attachments (optional)

You can attach any type of
files (e.g. spreadsheets,
pictures, text documents...).
Press the button or use the
Attachments menu to add
attachments.

You can also use the drag&drop method to drag files from the Explorer and
to drop them on the new message.
Name and size of attachments are listed at the bottom of the message.
Doubleclick on an attachment to open the 'Attachments' dialog that lets you
remove or add more attachments.
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5. Send the Message

Press the Send button on the
toolbar or select Send from
the Message menu to submit
the message for sending.

You can now find this message in the OUT folder. After the message has
been sent, it will move to the SENT folder.

Notes:
- When you submit the message for sending, the message is stored in the outgoing

queue. At what time the message will be sent to the destination station(s) or to the next
station(s) on the route depends on the Network Setup of your station (manual or
scheduled connection).

- The message and attachments are automatically compressed when sending. This
saves transmission time. The message is automatically decompressed on the
recipients side.

3.5. Sending and Receiving Messages
After you create a message, the message is not immediately sent. The
message will be sent the next time a link is established to the destination
station(s) or to the forwarding station(s).

You can manually establish a link by activating the Send+Receive button on
the toolbar or by selecting Send+Receive from the Connection menu. If
more than one link has been defined in the Network Setup, the 'Select Link'
dialog appears to let you select the desired link.

WaveMail can be configured to automatically establish links on regular
intervals, on predetermined times or when messages are in the queue (see
Network Setup)

After the connection has been established, WaveMail performs the login
procedure and exchanges messages and notifications between the two
stations. This is only possible if both stations are correctly configured (a link
between the two stations has to be defined on both stations, and passwords
must match).
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3.6. Folders and Message List
Messages are organized in folders. 5 folders are always available. You can
add additional folders.
- Received messages Contains received messages.
- Out messages Messages that have been queued for sending and

have not yet been sent to all destinations.
- Sent messages Messages that have been sent (if a message is

addressed to a station that can not be connected
directly, the message is moved from the Out folder
to the Sent folder after the message has been sent
to the next station on the route, not when it has
been delivered)

- Draft messages When creating a message you can save it in the
Draft folder if you want to edit the message before
sending

- Deleted messages Contains deleted messages.

3.6.1. Selecting a Folder
Use the Folder Selection drop-
down-list to select the desired
folder for display.

3.6.2. Sorting Messages
Click on a column header to
sort the message list by the
desired column. Click again to
revert the sort order.

3.6.3. Symbols in the Message List
Used symbols:

Unread message. The symbol will change to the 'Read message'
symbol after you doubleclick on the message.
Message has been read
Message has attachment(s)
Delivery notification
Non-Delivery notification
A red question mark next to the envelope marks a sent message, for
which a nondelivery notification has been received (message could
not be delivered to one or several recipients). Select the message
and press 'S' to get the status information for every recipient.
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3.7. Viewing and Managing Messages
The text of the currently selected message is displayed in the preview
window.
Doubleclick on the desired message on the message list to open the full
message (including attachments) for viewing.

3.7.1. Viewing a Message
Doubleclick on the desired
message on the message list
to open a message.

Attachments:
Doubleclick on an attachment
to see the popup menu that
lets you Open/Run or Save
attachments

3.7.2. Printing Messages
Select one or several messages in the message list and click on the Print
button of the toolbar.  If you have opened the message for viewing, you can
click on the Print symbol on the message windows toolbar. (You can setup
WaveMail to automatically print incoming/outgoing messages. See menu
Setup.) WaveMail will use the default printer for printing.

3.7.3. Responding to a Message
Select the desired message in the message list and click on the Reply button
of the toolbar.  A new message is created and the senders address of the
original message is automatically inserted in the 'To' field.
The original text is copied to the new message and original lines are
preceded by a '>' sign. You can select this text and delete it if you do not
want to include the original message in the response.

3.7.4. Forwarding a Message
Select the desired message in the message list and click on the Forward
button of the toolbar.  A copy of the message (including attachments) is
created. You can then select recipients and edit the message before sending
it.

3.7.5. Deleting Messages
1. Select one or several messages in the message list
2. Press the DELETE key   or   select Delete Messages from the File menu
If you delete a message in any folder except the 'Deleted Messages' folder,
the message is moved to the 'Deleted Messages' folder. You can recover the
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message by selecting the desired message(s) in the 'Deleted Messages'
folder and selecting the Move Messages function from the File menu.
After a message is deleted from the 'Deleted Messages' folder, it can not be
recovered.
Tips:
Selecting several messages in sequence:

1. Click on the first message
2. Press and hold down the Shift key while you click the last message of

the group

Selecting several messages out of sequence:
1. Press and hold down the Ctrl key while you click each message

From time to time you should use the Optimize Message Database function
from the Folders submenu of the File menu. This function reclaims space
released by deleted messages. This procedure may take several seconds.

3.7.6. Moving Messages
1. Select one or several messages in the message list
2. Use Move Message(s) to.. from the File menu to select the desired folder.

3.7.7. Popup Menu
Right-click in the message list
to open the popup menu for
quick access to message-
management functions.

3.8. Logout
If a POSTMASTER or several users have been defined on a station (see
Station Setup), then you had to enter username and password to access
your messages. In this case you should use Logout from the File menu to
prevent other persons from accessing your messages while you are out to
lunch.

After Logout, WaveMail can still send, receive and forward messages. It is
also possible to communicate with other WaveMail stations in Chat mode
without logging in.
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4. Modem Status Window

The Modem Status Window shows one line for every connected modem.

4.1. Description of status display

Column Description
Modem Name of modem. Corresponds to the name in the Station

Setup.
Call / Nr Callsign of connected radio modem (Swiss-PTC or Packet

Radio modem) or phone number of called telephone modem
Station Station-ID of connected station
Status Status of the link

For SWISS-PTC modems, the status is followed by an
asterisk '*' if the channel seems busy.
For SWISS-PTC modems, the status is followed by [P] if
the modem is in  Public Mode .

Estimated Estimated time that remains until all messages are received
or until all messages are sent. This value is only shown after
about 20 to 30 seconds in order to give a better estimation (
'??:??' is displayed during the first 20 seconds of a transfer).

Status Description
standby no activity
answering call WaveMail is answering an incoming call (establishing the

connection) on a telephone type modem
connecting establishing a connection
connected modem is connected
command mode WaveMail is waiting for the next command from the

remote station
login requested WaveMail has sent a login request to the remote station

and is exchanging credentials
wait login data WaveMail is waiting for login data from the remote station
messages
requested

WaveMail has asked the remote station to send
messages

TX WaveMail is sending messages. The net average bit rate
is displayed in bps or kbps. Because the displayed
number is the net bit rate (does not include protocol
overhead), it is lower than the effective number of bits
transferred.
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RX WaveMail is receiving messages
chat requested WaveMail is requesting an online dialog (chat mode)
terminal mode WaveMail is in chat mode (online dialog)
disconnecting ending connection
set channel WaveMail is setting the channel in the transceiver (only if

transceiver control is enabled, and only for Swiss-PTC
modems)

test channel free After setting the channel, WaveMail needs a few seconds
to test whether the channel is free (only for Swiss-PTC
modems)

4.2. Popup menu with modem functions
Select a modem in the modem status
window by clicking the modem. Then
rigth-click in the modem status window to
open the popup menu.  

Show Chat Window
Displays the Chat Window of the selected modem. This may be useful to
review an online dialog after you have been communicating in chat mode
with another station. You should limit the use of Chat Mode to a minimum
possible, because chat mode is inefficient compared to messaging.

Disconnect
End the connection on the selected modem.

Force Standby
You should only use this function in special cases. Force Standby cuts the
connection immediately, but the radio modem on the other side may keep on
sending for a while because no proper disconnect has been made.

Reopen Modem
Reinitialize the modem and the serial port. This may be useful if the modem
behaves in a strange way.
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5. Menu Functions
Some functions are only enabled if a user is logged in, some are only
enabled if the Postmaster is logged in.

5.1. File Menu
Many of the File menu functions operate on the selected message(s).
Tips:
Selecting several messages in sequence:

1. Click on the first message
2. Press and hold down the Shift key while you click the last message of

the group
Selecting several messages out of sequence:

1. Press and hold down the Ctrl key while you click each message

Many of the functions in the File menu are also available in the popup menu
that you can open by right-clicking on the message list.

5.1.1. New Message
Create a new message. Only one new message can be open at a time.

5.1.2. View Message
Open the selected message for viewing. It is usually more convenient to
doubleclick on the selected message or to press the Enter key.

5.1.3. Edit Message
This function is only available if a message in the 'Draft Messages' folder is
selected. Edit Message opens a message for editing.

5.1.4. Print Message(s)
Print selected messages. The character font used to print can be changed
with the Font function of the Setup menu. Messages are printed on the
printer that has been installed in Windows as the default printer. A quicker
way to print is to use the Print button of the toolbar. It is also possible to let
WaveMail automatically print incoming or outgoing messages (use the
Automatic Printing function of the Setup menu).

5.1.5. Move Message(s)
Move selected message(s) to another folder. This might be used to move
messages to a folder that you created.

5.1.6. Delete Message(s)
Delete selected message(s). If you delete a message in any folder except the
'Deleted Messages' folder, the message is moved to the 'Deleted Messages'
folder. You can recover the message by selecting the desired message(s) in
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the 'Deleted Messages' folder and selecting the Move Messages function
from the File menu.
After a message is deleted from the 'Deleted Messages' folder, it can not be
recovered.
A quicker way to delete the selected message(s) is the Delete key.

5.1.7. Folders/Database  -  New Folder
Create a new Folder with a name of your choice. This may help to organize
your messages.

5.1.8. Folders/Database  -  Delete Folder
Delete a folder. Only folders that you have created can be deleted. The 5
standard folders cannot be deleted. A folder must be empty before it can be
deleted.

5.1.9. Folders/Database  -  Optimize Message Database
This function will optimize the message database (release unneeded disk
space and re-order records for better performance). The operation may take
several seconds to complete.
Depending on your use of WaveMail you might invoke this function maybe
once a week or once a month.

5.1.10. Folders/Database  -  Backup Message Database
This operation will create a backup copy of the message database in
directory ...wavemail\users\username\mail\bak . If a backup exists already, it
will be replaced.
In case you ever need to restore the backup copy because of a database
corruption, you have to copy the files in the backup directory to the directory
one level above,
e.g. from c:\programs\wavemail\users\postmast.er\mail\bak
       to     c:\programs\wavemail\users\postmast.er\mail
The following files are saved as backup: msgs.dat, msgs.blb, msgat.dat,
msgat.blb, msgstat.dat.

5.1.11. Addressbook
If you are the POSTMASTER, this function lets you edit the 'Public
Addressbook' of a WaveMail station. The 'Public Addressbook' is available to
all users of a station, but only the POSTMASTER can change it.
Normal users can modify their 'Personal Addressbook' with this function.

5.1.12. Logout
This function is only available if a POSTMASTER or several users have been
defined on a station (see Station Setup). You can logout to prevent other



WaveMail 2.xx User Guide, August 2004 21

persons from accessing your messages while you are out to lunch. The
POSTMASTER may logout to prevent other persons from changing Station
Setup or Network Setup.
After Logout, WaveMail can still send, receive and forward messages. It is
also possible to communicate with other WaveMail stations in Chat mode
without logging in.

5.1.13. Exit
Stop WaveMail. WaveMail attempts to disconnect all links before exiting.
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5.2. Connection Menu

5.2.1. Send + Receive Mail
Exchange messages with a remote station. If only one link is defined in the
Network Setup, WaveMail will connect the station defined in this single link. If
several links have been defined, you can select the desired link from a list.
You can only exchange messages with a remote station which has defined a
link to your station in the remote stations Network Setup. If passwords are
used on this link, passwords must match, otherwise a login error will result.
WaveMail will connect, exchange Station-ID and Password and then transfer
the messages. First WaveMail sends messages to the other station. Then
WaveMail receives messages from the other station. After that, WaveMail
may exchange some notifications and then disconnect the link. Everything is
fully automatic and needs no user intervention.
WaveMail always sends messages sorted by size. The shortest message is
sent first, the biggest at the end.
You may sometimes wonder that WaveMail sends more messages than you
created. Maybe another user on your station has created some messages or
maybe your station is forwarding messages from other stations. The same is
true for received messages, if your station receives 3 messages, this does
not necessarily mean that all of them are for you.

You can use the  button of the toolbar for the same operation.
It is possible to configure WaveMail so that this function is automatically
executed at a regular interval, at certain times of the day or whenever
messages are queued for sending, see Network Setup.

5.2.2. Send Mail
Same as Send+Receive Mail , but no messages are received.

5.2.3. Receive Mail
Same as Send+Receive Mail , but no messages are sent.

5.2.4. Chat
Establish a connection with another station and open a Chat Window to
communicate in an online dialog. This may be helpful if you need an online
dialog with the other person.

5.2.5. Disconnect
Select a modem in the Modem Status Window and then use this function to
disconnect a link. This function is normally not used, because WaveMail will
automatically disconnect after exchanging messages.
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5.3. Special Menu

5.3.1. Show Connect Log
Open the 'Connect Log'. The 'Connect Log' shows a summary of the last 200
connections or connect attempts. The newest entry is on top of the list.

Column Description
Time Date and time when connection was disconnected
Station Station-ID of remote station
Modem Modem used
Result OK: everything went fine

connect failed: connect attempt failed
channel busy: channel was busy
remote busy: remote modem was busy
failed: link failure
login error: remote station has not defined a link with your
                    station, wrong Station-ID, wrong Password
timeout: no response from remote station
manual disconnect: message transfer was interrupted by
                                  manual intervention
auto-disconnect: WaveMail disconnected because of no activity
transceiver control error: no response from transceiver
protocol error: error during message transfer

X X connection was established by this station.
1,2,3... indicates that the connection was established by

this station and the radio channel used.
- connection was established by the remote station.

Minutes Duration of connection in minutes
Sent Number of bytes sent and in brackets number of messages and

notifications sent. The number of bytes indicates the net byte
count of the compressed message(s).

Received Number of bytes received and in brackets number of messages
and notifications received. The number of bytes indicates the net
byte count of the compressed message(s).

The button Copy to Clipboard copies the headers as well as the listed
connections to the clipboard. You can then paste this information into an
other document which can then be printed or saved.

The entries in the 'Connect Log' are also saved in a daily log file in the Log
subdirectory of the WaveMail directory. Log files are automatically deleted
after 60 days. (see Appendix for file format)
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5.3.2. Show Queued Messages
Open the 'Queued Messages' window. The 'Queued Messages' window
shows the list of messages queued for sending (if any).

Column Description
Next station destination station or next station in route of message
From originator of message
Msg-Id message-id of message
Queued date and time the message was queued
Size size in bytes of the (compressed) message

The same message (identical message-id) may appear multiple times if it is
addressed to several recipients.
The list can be sorted by any column. Just click on a column header to sort
the list. Click again to revert the sort order.

Redirect queued messages
The Redirect button is only visible if you are logged in as  POSTMASTER.
Redirecting messages does not change the recipient(s), redirecting only
changes the route the message(s) will take. This function is only needed on
special circumstances.
If messages are in the queue for STATIONX and STATIONX is not working
anymore, you might have an alternative station STATIONY in your network
that would handle the forwarding of messages.
Select one of the messages queued for sending to STATIONX. Then activate
the Redirect queued messages button. Select the desired station in the
'Redirect queued messages' dialog.
Note: You will probably never need this function, however it is available, just
in case.

Delete message
The Delete button is only visible if you are logged in as POSTMASTER.
It should normally not be necessary to delete a message from the queue.
However, in special cases it might be useful (e.g. if someone has sent a very
large message which is now in the queue to be transmitted over a relatively
slow link like a HF-radio link where it would block the channel for hours. In
this case you might want to kill this message).
Note: To prevent from having very large messages block your transmission
channels you can assign a maximum message size to every modem (see
Station Setup).

Save to Clipboard
This function copies the headers as well as the list of queued messages to
the clipboard. You can then paste this information into an other document
which can then be printed or saved.



WaveMail 2.xx User Guide, August 2004 25

5.3.3. Show Link Scheduler
WaveMail can be configured to automatically establish connections (links)
with other WaveMail stations at regular intervals or at preprogrammed times,
see Network Setup .
The Link Scheduler window gives an overview of configured links and
schedules.

Column Description
Linkname Identifies a link by the name of the remote station and the

modem used.
Last Attempt Time when the last attempt to establish the link has been

made. This field is empty if no schedule has been defined.
Next Attempt Next time when WaveMail will try to establish the link, this is

either the next scheduled time or the time an automatic retry
is due.
This column shows 'no schedule' if no schedules have been
defined.
An asterisk '*' in this column indicates that a link will be
established when a message has been queued for sending.

Busy YES indicates that a link is established or is being
established.

If WaveMail fails to establish a link on the scheduled time, it will automatically
retry after a preprogrammed interval. After 3 unsuccessful attempts (per
channel) WaveMail gives up and will try to establish the link on the next
scheduled time. The case where the channel, line or remote modem is busy
is not counted as an attempt and WaveMail will keep on trying with short
intervals.

5.3.4. Modem Functions - Show Chat Window
Displays the 'Chat Window' of the selected modem. This may be useful to
review an online dialog after you have been communicating in chat mode
with another station. You should limit the use of Chat Mode to a minimum
possible, because chat mode is inefficient compared to messaging.

5.3.5. Modem Functions - Force Standby
You should only use this function in special cases. Force Standby cuts the
connection immediately, but the radio modem on the other side may keep on
sending for a while because no proper disconnect has been made.

5.3.6. Modem Functions - Reopen Modem
Reinitialize the modem and the serial port. This may be useful if the modem
behaves in a strange way.
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5.4. Setup Menu

5.4.1. Font - Screen
Select the font used to display the message text on the screen. The font for
text other than the message text cannot be changed.

5.4.2. Font - Printer
Select the font used for printing messages.

5.4.3. Email Signature Text
Define a text that will be appended to all messages you create.

5.4.4. Automatic Printing
Select automatic printing options.
Messages are only printed automatically while the respective user
(recipient/sender of the messages) is logged in. Messages are printed on the
default printer.
These options are private to users and therefore each user can set different
options.

5.4.5. Station Setup
The Station Setup function is only available for the POSTMASTER.
Use Station Setup to configure parameters for your WaveMail station. The
following minimum informations are required before you can use WaveMail:
- enter the Station-ID
- enter the License Code
- add a Modem

see chapter Advanced Setup for more information

5.4.6. Network Setup
The Network Setup function is only available for the POSTMASTER.
Use Network Setup to define links (connections) with other WaveMail
stations. The following minimum information is requeired before you can use
WaveMail to exchange messages with another station:
- define at least one Link to another WaveMail station

see chapter Advanced Setup for more information

5.4.7. Show Parameters
This function is for information only. A summary of parameters is displayed
for quick information.
see chapter Advanced Setup for more information
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5.5. Popup Menu in Message List
Right-click in the
message list to open the
popup menu for quick
access to message-
management functions.

Most of these functions are self explaining or are explained in the section
'Viewing and Managing Messages'.

5.5.1. Show Status - Message Status
Select a message of the OUT Messages or SENT Messages folder. Open
the popup menu by right-clicking. Then select  Show Status from the popup
menu to display the status of the desired message.
The message status window displays the status for every recipient. If a
delivery or a non-delivery notification has been received, the status of a
message is updated and the notification is stored in your RECEIVED
Messages folder.
Status Description
queued message is in the send queue
sent message has been sent (either to the destination

station or to the next station on the route to the
destination station)

delivered message has been delivered (this status is only
available if a delivery confirmation has been requested
when the message was created)

address unknown address unknown
recipient unknown the message has arrived at the destination station, but

there is no recipient with this username at the
destination station (the message is delivered to the
POSTMASTER of the destination station)

deleted the message has been removed from the send queue
(on this station or on a station between this station and
the destination station)

timeout the message was not forwarded for more than 2 days
(on this station or on a station between this station and
the destination station)

msg too big the message could not be sent, because it was bigger
than the maximum specified in Station Setup / Modem
properties

The Subject of the message is shown for reference. The message-id (Msg Id)
is an internal identifier that uniquely identifies every single message.
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6. Addressbook
The e-mail addresses of your contacts can be saved in the Addressbook.
When you create a message, you can select recipients from the
addressbook.

6.1. Public Addressbook and Personal Addressbook
The  'Public Addressbook' is maintained by the POSTMASTER and all users
can use it when selecting recipients for a new message.
The 'Private Addressbook' is maintained by normal users and only the owner
of a 'Private Addressbook' can use it when selecting recipients for a new
message.
Normal users can only modify the 'Private Addressbook'. The 'Public
Addressbook' can only be modified by the POSTMASTER.

6.2. Adding contacts to the Addressbook
Select Addressbook from the
File menu to modify the
addressbook. When you are
selecting recipients for a new
message ('Select Recipients'
dialog), you can activate the
Modify Addressbook button
to add new contacts to the
addressbook.

Use the following buttons in the addressbook:
 - Use Add Address to add a new address.
 - Use Add List to add an address list.
 - Use Edit to modify the selected address or address list.
 - Use Close to close the addressbook.

6.2.1. Enter name and address
After you select Add Address
or Edit, you will see the
'Address' dialog.

Name
You can enter any name. You may enter the last name first, in order to see
the contacts sorted by lastname.
E-mail Address
Enter a valid e-mail address. See chapter 'E-mail Addresses in WaveMail' for
details.
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6.3. Addresslists
Addresslists contain a list of recipients. Addresslists are very convenient
when you often have to send messages to the same group of persons. A
message can be addressed to all members of an addresslist by a single
mouseclick.

Use Add List in the address-
book to add an address list.

List name
An address list is identified by
the list name. You can enter
any name or description into
this field.
Example: Branch Offices Africa

Recipients
The Recipients list on the right
side contains the members of
this addresslist. Select the
desired recipients from the left
list and click on the > button to
include the selected recipients
in your addresslist. Use the <
button to remove members of
your addresslist.
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7. E-mail addresses in WaveMail

7.1. WaveMail address
A WaveMail address can consist of the Station-ID or a Username and the
Station-ID. Username and Station-ID  are separated by a period.
Examples:

nairobi
hermann_schuemperlin.nairobi
john.smith.nairobi
billclinton.washington

7.2. Other types of address

7.2.1. Internet address
Normal Internet e-mail addresses can be used when sending a message to
an Internet recipient. WaveMail will automatically recognize Internet e-mail
addresses and try to forward the message to a WaveNet gateway
(WaveMail-Internet gateway) within your WaveMail network (of course you
can only send messages to Internet recipients if a gateway is running in your
WaveMail network and if you have the rights to send messages to Internet
recipients).
Example:

hermann@schuemperlin.com

7.2.2. GLPLUS/RLPLUS address
You can address messages to stations that use GLPLUS or RLPLUS
software. The address consists of the keyword 'GP:' and the call sign of the
remote SWISS-PTC or Packet Radio modem.
Example:

GP:hb9cnm

see also section 'GLPLUS/RLPLUS Compatibility' in 'Appendix B'.
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8. WaveMail over TCP/IP

8.1. Overview
WaveMail supports TCP/IP links as connection between two WaveMail
stations. This is very convenient in places where a connection to the Internet
is available but not reliable, because
- you can benefit from low traffic charges via Internet as long as the Internet

access is ok
- WaveMail can use other types of connections (Pactor, Packet Radio,

Inmarsat...) when the Internet access is down

The calling WaveMail station (client) can use a Dial-Up or a permanent
connection to the Internet.
The called WaveMail station (server) should have a permanent connection to
the Internet and a fixed IP-Address.
Typically you would setup the WaveMail station in your headquarter as a
TCP/IP-Server. The remote WaveMail stations can then access this server
over TCP/IP (or Pactor, or Inmarsat, or ...).

More than one WaveMail station in a network can be setup as a TCP/IP-
Server, however all TCP/IP-Servers should have permanent Internet access
and a fixed IP-Address. A WaveMail station can be setup as TCP/IP-Client
and/or TCP/IP-Server.

8.2. Setup and operation of a WaveMail TCP/IP-Client station

8.2.1. Internet access
The PC where WaveMail is running must have access to the Internet, either
via a Dial-Up connection or via a permanent connection. It is assumed that
you have a well configured and working Internet access before you continue.

8.2.2. Prepare WaveMail for use of TCP/IP
1. Select Station Setup from the Setup menu
2. Activate the Add Modem button in the 'Station Setup' dialog (the word

"modem" is a bit misleading, you do not add a modem, you add a TCP/IP-
Connection. But because the procedures are very similar to adding a
Swiss-PTC-Modem or a Telephone-Modem etc., we just kept the
wording.)

3. Select TCP/IP in the 'Add Modem' dialog.
4. Select the appropriate options in the 'Modem Properties' dialog
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Make dial-up connection
Check this option, if WaveMail should automatically establish the dial-up
connection when necessary.

Always disconnect
Select this option, if WaveMail should always disconnect the dial-up
connection after messages have been exchanged.

Disconnect only when dialled by WaveMail
Select this option, if WaveMail should only disconnect the dial-up
connection when WaveMail has established the dial-up connection (this
prevents WaveMail from disconnecting when the dial-up connection was
already established by another application before WaveMail started to
transfer messages).

Notes:
- If your PC does not have a permanent link to the internet, then it is

recommended to select the options Make Dialup Connection and
Always Disconnect

- If the option Make Dialup Connection is activated, WaveMail will
establish the 'default dial-up connection' as defined  in Windows.

8.2.3. Define a WaveMail link over TCP/IP
1. Select Network Setup from the Setup menu
2. Activate the Add button on the "Links" page of Network Setup
3. On the 'Link Properties' dialog:

- enter the Station-ID
- select TCP/IP as modem
- enter IP-Address and Port-Number of the remote station in the Phone

Number/Call line. IP-Address and Port-Number must be separated by a
colon ':' . Below you find an example for IP-Address 193.200.322.15
and Port 56789

    Example:
    193.200.322.15:56789

8.2.4. Establishing a connection over TCP/IP
Establishing a connection over TCP/IP works exactly the same way as for
connections over SWISS-PTC or Telephone-Modems:
1. Use the Send+Receive button or the functions of the Connection menu
2. Select the desired link (which you have defined in 'Network Setup', see

above).

If you cannot establish a connection, check the following:
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- is your Internet access OK (test Internet access with the normal Windows
Dial-Up function)

- is the IP-Address correct
- is the Port-Number correct
- is the station you are calling configured as TCP/IP-Server

If you get a 'Login failed' error message, then the called TCP/IP server
station has not defined a link with your station or you are using a wrong
password (the connection works but you are not allowed to exchange
messages).

8.3. Setup of a WaveMail TCP/IP-Server station
A WaveMail TCP/IP-Server is a WaveMail station which can accept incoming
TCP/IP connect-requests from another WaveMail station. A WaveMail
TCP/IP-Server should have a permanent connection to the Internet and it
should have a fixed IP-Address.
Typically you would setup the WaveMail station in your headquarter as a
TCP/IP-Server. The remote WaveMail stations can then access this server
over TCP/IP (or Pactor, or Inmarsat, or ...).
You have to manually edit the file WAVEMAIL.INI to setup WaveMail as a
TCP/IP-Server. Exit from WaveMail and make a backup-copy of
WAVEMAIL.INI before you edit this file.

8.3.1. Changes in WAVEMAIL.INI

8.3.1.1. Minimum Setup
Add the following lines to WAVEMAIL.INI:
  [TCPIPserver]
  enabled=1
As a default, WaveMail will offer 5 Sockets, allowing 5 concurrent
connections over TCP/IP. The WaveMail TCP/IP-Server will listen on Port-
Number 56789 for incoming connections. See below to change these
defaults.

8.3.1.2. Number of sockets
If you need more or less concurrent connections than the default value, you
can add the line
  sockets=n
where n must be in the range 1..10.

8.3.1.3. Port-Number
As a default WaveMail will listen on Port 56789. In order to define a different
Port-Number, you can add the line
  port=n
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where n must be a valid port number. Remote stations must know the
defined Port-Number in order to connect to the TCP/IP-Server.

8.3.1.4. Example for settings in WAVEMAIL.INI
[TCPIPserver]
enabled=1
sockets=7
port=4711

8.3.1.5. Remarks
- The changes in WAVEMAIL.INI will only be effective after you restart

WaveMail.
- If you are using a firewall, make sure that connections to the defined Port-

Number are enabled.
- Make sure that the selected Port-Number does not conflict with other

applications.
- Make sure you do not insert the lines within the lines of an other section in

WAVEMAIL.INI.

8.3.2. Network Setup
Only remote stations for which a link has been defined in the 'Network Setup'
(menu Setup - Network Setup) can exchange messages with your TCP/IP-
Server station. However, if a remote station sometimes connects using
TCP/IP and sometimes connects using a SWISS-PTC or another modem,
then it could be sufficient to enter just one link (even if only a link over
SWISS-PTC is defined, the remote station can connect over TCP/IP).
But if you are using the "Maximum Message Size" option (in Setup / Station
Setup / Modem Properties), then you should at least define a link over the
modem which has the biggest (or unlimited) value for "Maximum Message
Size" (links over other modems can also be defined but the link over the
modem with the biggest value for "Maximum Message Size" is important,
because otherwise messages might be rejected by WaveMail) (background:
from those modems over which links are defined to a particular remote
station, WaveMail takes the highest value of "Maximum Message Size" to
determine whether a message should be accepted for that station or rejected
because of oversize).
If you define a link over TCP/IP for a remote station, then you will probably
not know the IP-Address of the remote station, because that station
probably does not have a fixed IP-Address (dial-up). In this case you can
enter any value in the 'Phone number/Call of remote station' field (e.g.
0.0.0.0) because this value is only used when your station is calling the
remote station. If the remote station calls, the value of  the  'Phone
number/Call of remote station' field is not used.
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9. Advanced Setup

9.1. Station Setup
Choose Station Setup from the Setup menu to change parameters of your
WaveMail station.
The Station Setup can only be changed by the Postmaster.

9.1.1. Station-ID
The Station-ID is used to identify a station in the network. Other stations will
use your Station-ID to address messages to your station and to establish
connections with your station.
The Station-ID must be a unique identifier, every station needs a different
Station-ID. It is recommended to use a meaningful name, maybe the name of
the city where you are located or a combination of abbreviations of your
organizations name and the city name.
The Station-ID is limited to 11 characters.
Valid characters are: 'A' - 'Z' , '0' - '9' , and '_'.
The Station-ID is not case sensitive.

Examples:
Nairobi
US_Houston
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9.1.2. License Code
The License Code is used to protect the WaveMail software from
unauthorized use. This software has to be licensed for every station, this
means an individual license is needed for every PC that has modems
connected which are used by WaveMail.
You get the License Code from the supplier of this software. The License
Code is related to the Station-ID. Therefore you have to pay the License Fee
and to communicate your Station-ID and company name to the supplier of
this software in order to get the License Code.
WaveMail can only be used after the correct License Code that corresponds
to the Station-ID has been entered.

9.1.3. Modems
Up to 7 modems can be connected to a WaveMail station. In most cases you
will only have one or two modems.

Use the Add Modem button to add a modem.  You will then be asked what
type of modem you want to add.

- All SWISS-PTC modems (SWISS-PTC plus, SWISS-PTC II, SWISS PTC-
2A)  can be defined as 'SWISS-PTC'

- Packet radio modems supporting WA8DED hostmode (including RDM-48)
can be defined as 'Packet WA8DED'

- All telephone modems with an AT-command set can be defined as
'Telephone Modem' or they can be defined as 'Windows Modem ( TAPI )'.
If 'Windows Modem (TAPI)' is selected, then you will be asked to select
the desired device from a list of installed modems (see section 'TAPI
Overview, Advantages and Disadvantages' in chapter 'Special Topics).

- Select 'TCP/IP' if you want to establish a connection with another
WaveMail station over TCP/IP. Of course TCP/IP is a protocol and not a
modem, but the word 'modem' is just kept because all the other selections
('SWISS-PTC', 'Telephone-Modem' ... are modems).

After you select a modem type, the 'Modem Properties' dialog allows you to
enter the properties for the modem.
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9.1.4. Modem Properties
Use the Properties button next to the desired modem to change the
properties of a modem.
Some of the fields of the  'Modem Properties' dialog are not visible for certain
types of modems.

Com-Port
Select the COM port where the modem is connected.

Baudrate
Select the appropriate Baudrate for communications between the modem
and the PC (this is NOT the over-air or line baudrate).
- The Baudrate does not have to be defined for SWISS-PTC Pactor

modems (SWISS PTC 1 and SWISS PTC II) because WaveMail will
automatically detect the correct baudrate.

- Telephone modems usually have an autobaud routine and accept many
baudrates. Select a baudrate which is higher than the line speed.

- For Inmarsat terminals you should check the baudrate selected on the
terminal.

- For Packet modems you have to specify the baudrate that has been
selected in the modem. Use 9600 for the RDM 48 modem.

Call (for radio modems)
The Call (selcall) is needed for radio modems. WaveMail will automatically
program the modem with the Call you define here. Remote stations must
know your Call in order to establish a connection from the remote side.

Line Access (for 'Telephone Modems')
If your telephone modem is connected to a PBX, it will probably be necessary
to dial a line access code and instruct the modem to wait with dialing the
number until the external line is ready. Typical access codes are 0w or 0,, .
Leave this field empty if the modem is directly connected to an external line.
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If you select 'Windows Modem (TAPI)' instead of 'Telephone Modem', then
you can adjust the settings in the Windows Control Panel.

Dialing (for telephone modems)
Select Tone dialing if possible, use Pulse dialing if Tone dialing does not
work (depends on telephone exchange).

Answer incoming calls (for telephone modems)
Check this box if incoming calls should be answered. Uncheck this box if this
modem is only used for outgoing connections. If you share the same line for
voice calls and data calls you might not want that the modem answers
incoming calls.

Remove Modem
Click on the Remove Modem button to remove the modem from the setup.

Advanced Setup
Click on the Advanced Setup button to change any of the following
properties:

Initialization string(s)
Normally everything should work fine without additional initialzation strings.
However there are cases where some special initialization is required. You
can enter several lines.
For SWISS-PTC modems: the first line must contain the 'LOCK 0 ' command
Examples: SWISS-PTC modem:

LOCK  0
PSKA  280
FSKA  200

Packet radio modem:
P  128
@T2 20

Maximum message size in kB
You can define a maximum size for messages that may be sent over this
modem. This may help to prevent from exorbitant costs if an extremely large
message has been sent by accident. If this field is empty or '0' this is
interpreted as 'unlimited'. The size is always the size of the compressed
message. A message which shows a size of 100kB in your OUT Messages
folder might have been compressed to 30 kB and will be transmitted even if
the limit has been set to 50kB.

Transceiver Control
This option is only applicable to SWISS-PTC modems. It is used to define the
type of radio used if WaveMail should automatically control the transceiver
channel when establishing connections.
Leave this field empty (select '--disabled--' from the list) if you only use a
single frequency.
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Disabled
You can check the Disabled checkbox if you want to temporarily disable a
modem without completely removing it from the setup.

9.1.5. Local Users
Several local users can be defined. This allows to address messages to an
individual person.
- Select Add User to add a new user. The 'Username and Password' dialog

appears and you can enter the Username and Password. The first
registered user is always the POSTMASTER.

- Select User Properties to change the password of the selected user.
- Select Remove User to remove a user. This will also delete all mail of the

removed user (except if WaveMail is running on a LAN and the user has
his mail on his PC where WaveMail is running in Client mode).

Username
The username is used to login and to address messages to a specific user.
Valid characters are:  'A' - ' Z'  ,  'a' - 'z'  ,  '0' - '9' ,  '-',  '_',  '.'
Maximum length:  40 characters
Examples:

john-smith
James007
Hermann.Schuemperlin

Note: Usernames are not case sensitive. This means that 'Miller' and 'miller'
is interpreted as the same user.

Password
The password  is used to login.
Valid characters:  all characters
Maximum length:  30 characters

Note: Passwords are not case sensitive.
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9.2. Network Setup
The 'Network Setup' can only be changed by the Postmaster.

9.2.1. Links
The 'Links' page allows you to define links between your WaveMail station
and other WaveMail stations. A link is characterized by:
- Station-ID of the remote station
- modem to be used (WaveMail can handle several modems)
- phone number / call of the remote station
- optionally a password

Activate the Add or Properties button to add/modify a link.

Important note:
- You can only exchange mail with remote stations after you have defined

the parameters for the link to that station. You can only exchange mail
with remote stations which have defined a link with your station. If a
password has been assigned for a link, the password must be the same
on both sides of the link.

- Chat connections (online dialog) are not protected, therefore you can chat
with a remote station even if the remote station has not defined a link with
your station or if the passwords do not match.

- If your station has more than one modem connected, then a remote
station can exchange mail through any modem as long as at least one link
to that particular remote station has been defined (if the link is defined for
modem1, the remote can also connect on modem2 and exchange mail
even if no link over modem2 is defined).
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9.2.2. Link Properties

Messages can only be exchanged, if the remote station has defined a link
with your station and if the passwords (if used) are the same.

Station-ID of remote station
Enter the Station-ID of the remote station. If you want to chat with a remote
station which is not using WaveMail, you can enter any name as Station-ID,
however you can only exchange messages with other WaveMail stations if
you enter the correct Station-ID.
If you want to exchange messages with stations that are running the
GLPLUS or RLPLUS software you must enter a special Station-ID of the form
'GP:call'' where call must be set to the call sign of the remote SWISS-PTC or
Packet Radio modem, example:  GP:hb9cnm.

Modem
Select the modem that should be used to establish a connection with the
remote station. The remote station must have the same type of modem. A
drop-down list lets you choose from the modem(s) defined in your Station
Setup.

Phone number / Call of remote station
If you use a telephone modem or an Inmarsat terminal to connect to a remote
station, then you have to enter the phone number of the remote station.
If you use a SWISS-PTC Pactor modem or a Packet Radio modem you have
to enter the callsign of the remote station.
Notes:
- Callsign and  Station-ID are two different things, however they may have

the same value.
- To connect a SWISS-PTC modem in Longpath-Mode, the callsign must be

preceded by a '!' sign
- To connect a SWISS-PTC modem in Public-Mode, the callsign should be

preceded by a '+' sign.
Example: !hb9cnm   connect hb9cnm in Longpath-Mode
Example: +hb9cnm   connect hb9cnm in Public-Mode
Example: +!hb9cnm   connect hb9cnm in Longpath and Public-Mode
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Password
A link between two stations may be protected by a passsword. This is very
useful in order to prevent from unauthorized intrusion into your messaging
network.

Scheduled connections
You can configure WaveMail to automatically establish a link and exchange
messages at regular intervals or at specific times.
If you select 'Connect at regular intervals', you can define the interval in
minutes and the starttime in hours and minutes. The starttime allows you to
arrange the connect times so that not all links will connect at the same time.
If you select 'Connect at specific times' you can enter a list of times in the
hh:mm format (hours:minutes).

Connect when message(s) queued
If you check this box, WaveMail will automatically establish a connection on
this link if a message is queued for the station defined in this link. If the a link
has recently been active, WaveMail will not immediately reconnect. In this
case WaveMail will only connect after a delay of one to several minutes.

Channels
This button is only visible if a SWISS-PTC is used on this link and if
'Transceiver Control' has been defined for this modem (see also section
'Station Setup' and 'Modem Properties').  Use the Channels button to define
the channel(s) to be used when establishing the connection.

On the left side of the dialog
you may define up to 3
channels to be used when
establishing a connection
during the time specified in the
Between / And fields. On the
right side of the dialog you may
define up to 3 channels for the
rest of the day. This allows
adaptation to changing
propagation conditions.

WaveMail first attempts to connect on 1. Channel . If the connection fails,
WaveMail attempts to use the 2. and 3. channel (if defined). If still no
connection is possible, WaveMail will retry several times (with a delay
between attempts).
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9.2.3. Routing

WaveMail may need some informations in order to find the route to deliver
messages. WaveMail automatically forwards messages until they arrive at
the destinations. If you have only one link defined, you can leave the 'Default
Routing' field and 'Specific Routing' list empty because WaveMail will send all
messages over that single link.

Default Routing
Messages for destinations with no direct link are sent to the station specified
in the 'Default Routing' field (unless specific routing for that particular
destination has been defined). WaveMail assumes, that the station that has
been defined in the 'Default Routing' field will know how to forward
messages. If you have only one link defined, you can leave this field empty
and WaveMail will use this single link for default routing.

Specific Routing
You can specify a specific forwarding station for messages which are
addressed to a certain destination station.
Use the Add and Remove buttons to add/remove specific routing
informations.

Background information for better understanding:
If WaveMail has to forward a message to STATIONX it will use the following scheme to
decide where to send the message next:
1. If a Specific Routing has been defined for STATIONX, then WaveMail uses this

routing information.
2. If a Link with station STATIONX is defined, then WaveMail will forward the message

over this link.
3. If neither 1 nor 2 are true, then WaveMail will forward the message to the station

defined in the Default Routing field.
4. If neither 1 nor 2 are true and no Default Routing is defined, then WaveMail will return

a 'Address Unknown Notification' to the originator of the message.
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9.3. Transceiver Control
WaveMail supports automatic control of transceiver channels (channels not
frequencies!) if a Swiss-PTC modem is used.
The following transceivers are supported as standard:

- Icom M-700 TY types with Scanner Control
- Barrett 950
- Codan 9360
- Use integrated Transceiver Control of Swiss-PTC-II (SWISS-PTC-II

TRX-CONTROL)

Other transceivers are supported on request.

If you are using the integrated Transceiver Control of the Swiss-PTC-II, then you must program the channels
and scan parameters in the Swiss-PTC-II. You can do this in SETUP / STATION SETUP / MODEM
PROPERTIES. You have to add a few lines in the Initialization String(s) box. Example:

lock 0
trx ty r 9600
trx ch 1 14280.5
trx xscan 1 1
trx ch 2 7200.8
trx xscan 2 1
trx wait 10
trx dwell 30
trx scan 1

For details, contact Schuemperlin Engineering AG.

9.3.1. Setup for Transceiver Control
Before you can use Transceiver Control you have to perform the following
tasks:
1. A control cable has to be connected between the Swiss-PTC modem and

the transceivers control port.
2. Program the desired channels on the transceiver.
3. Station Setup: The appropriate transceiver type must be selected in the

'Transceiver Control' field of the 'Modem Properties' dialog of the Swiss-
PTC modem.

4. Network Setup: Use the Channels button of the 'Link Properties' dialog to
enter the desired channels for every link.
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9.4. Step-by-Step Setup Examples
The following examples  show a network that grows from a very simple 2
station network to a network with several stations and different types of
modems.

Every station in a WaveMail network has to be identified by a Station-ID. The
Station-ID is NOT the same as the callsign of a radio modem (however, they
may have the same value). The Station-ID is used to establish links between
stations and to address messages.
The organisation in this example has decided to use city names or
abbreviations of city names as Station-IDs. The corresponding License
Codes are obtained from the supplier of WaveMail.
In this example, callsigns for radio modems are organized as follows:
2 letter company code (se  for setup example), followed by 2 letter country
code, followed by 2-4 letters city code.
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9.4.1. Minimum WaveMail Network with 2 Stations
This example shows a simple WaveMail network with 2 stations in Geneva
and Nairobi using SWISS-PTC HF-radio modems.

The operators (POSTMASTER) in Geneva and Nairobi use the Station
Setup function of the Setup menu to define Station-ID, License Code and
Modem.
Then they use the Network Setup function of the Setup menu to define the
parameters for the link to Geneva / Nairobi. It is important to define the link
on both stations of the link, otherwise a Login Error will occur when
attempting to send/receive messages.

HF

Swiss-PTC
Call:sechgva

Station-ID:   GENEVA

Swiss-PTC
Call:sekenai

Station-ID:   NAIROBI

Simple network with 2 stations using Swiss-PTC modems.

Setup in Geneva
Station Setup
Station-ID = GENEVA
License Code = license code

Add a modem:
Modem type = SWISS-PTC
Call = sechgva

Network Setup
Add a link to Nairobi:

Station-ID of remote stat. = NAIROBI
Modem = SWISS-PTC
Call of remote station = sekenai

Setup in Nairobi
Station Setup
Station-ID = NAIROBI
License Code = license code

Add a modem:
Modem type = SWISS-PTC
Call = sekenai

Network Setup
Add a link to Geneva:

Station-ID of remote stat. = GENEVA
Modem = SWISS-PTC
Call of remote station = sechgva

No routing information is necessary in this example and the Routing page of
the Network Setup on both WaveMail stations is empty.
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9.4.2. A third Station joins the Network
A new station in Kabul joins the network. Kabul uses a Swiss-PTC modem.
The operator in Kabul uses the Station Setup function of the Setup menu to
define Station-ID, License Code and Modem. Then he uses the Network
Setup function of the Setup menu to define the parameters for the link to
Geneva.
The operator in Geneva uses the Network Setup function of the Setup menu
to define the parameters for the link to Kabul. It is important to define the
link on both stations of the link, otherwise a Login Error will occur
when attempting to send/receive messages.

HF

HF

Swiss-PTC
Call:sechgva

Station-ID:   GENEVA

Swiss-PTC
Call:sekenai

Station-ID:   NAIROBI

Station-ID:   KABUL

Swiss-PTC
Call:seafkab

New station

Setup in Kabul
Station Setup
Station-ID = KABUL
License Code = license code

Add a modem:
Modem type = SWISS-PTC
Call = seafkab

Network Setup
Add a link to Geneva:

Station-ID of remote stat. = GENEVA
Modem = SWISS-PTC
Call of remote station = sechgva

Setup in Geneva
Station Setup

no change
Network Setup
Add a link to Kabul:

Station-ID of remote stat. = KABUL
Modem = SWISS-PTC
Call of remote station = seafkab

A direct link between Kabul and Nairobi could also be defined. However, in
our example this is not done, and all messages between Kabul and Nairobi
are transferred via Geneva (automatic Store-and-Forward in Geneva).
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9.4.3. A Station with a different Modem joins the Network
A new station in Nairobi joins the network. The Station-ID NAIROBI2 is
assigned to this station. Because the two stations in Nairobi are within a
relatively short distance, Packet Radio modems on VHF or UHF are used to
connect NAIROBI2 and NAIROBI.

HF

HF

VHF/UHF

Swiss-PTC
Call:sechgva

Station-ID:   GENEVA

Swiss-PTC
Call:sekenai

Station-ID:   NAIROBI

Station-ID:   KABUL

Station-ID:   NAIROBI2

Packet
Call:seken1

Packet
Call:seken2

Swiss-PTC
Call:seafkab

New station

Setup at NAIROBI2
Station Setup
Station-ID = NAIROBI2
License Code = license code
Add a modem:

Modem type = Packet WA8DED
Call = seken2

Network Setup
Add a link to NAIROBI:

Station-ID of remote stat. = NAIROBI
Modem = Packet WA8DED
Call of remote station = seken1

Setup at NAIROBI
Station Setup

Add a modem:
Modem type = Packet WA8DED
Call = seken1

Network Setup
Add a link to NAIROBI2:

Station-ID of remote stat. = NAIROBI2
Modem                  = Packet WA8DED
Call of remote station = seken2

As the network gets more complex, WaveMail needs some routing
information.
Imagine that KABUL writes a message for NAIROBI2. The WaveMail station
in Kabul will forward the message to Geneva, because there is no other
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choice (only 1 link defined). Now the WaveMail station in Geneva is having a
problem:
to which station should Geneva forward a message for NAIROBI2 ?

Therefore the operator in Geneva uses the Network Setup function of the
Setup menu to define routing information for messages destined to
NAIROBI2. He clicks on the Routing page of the Network Setup dialog. Then
he activates the Add button and enters the routing information.

Setup in Geneva
Station Setup
   no change

Network Setup
Add specific routing for NAIROBI2:

Destination station = NAIROBI2
Forward via = NAIROBI

As the station NAIROBI now has 2 links, this WaveMail station is also having
a problem:
to which station should NAIROBI forward a message for KABUL?

The operator in Nairobi could add specific routing information for messages
destined for Kabul. However, there is another possibility. The operator at the
NAIROBI station can use the the 'Routing' page of the 'Network Setup' dialog
to define a 'Default Routing' station. He selects GENEVA as the 'Default
Routing' station, because Geneva is the central station of this growing
network. This solution has the advantage, that Nairobi does not have to
update the routing information for every new station in the network. WaveMail
assumes that the station defined as 'Default Routing' station knows how to
forward messages.

Setup at NAIROBI
Network Setup
Define Default Routing:

Default Routing = GENEVA



50 WaveMail 2.xx User Guide, August 2004

9.4.4. WaveNet Internet Gateway
The WaveMail network in our example is now enhanced by a WaveNet
gateway to the Internet. The gateway is installed at the WaveMail station in
Geneva. See the WaveNet User Guide for installation informations.

Now messages can be exchanged between the Internet and WaveMail,
normal Internet e-mail addresses can be used. In our example a user at the
NAIROBI2 station might address a message to info@schuemperlin.com .
WaveMail automatically interprets this address as an Internet e-mail address.
The message will be forwarded to NAIROBI (this is the only link from
NAIROBI2). NAIROBI will forward the message to GENEVA (Default
Routing). WaveMail in GENEVA will forward the message to the WaveNet
gateway where the FROM: address is mapped and the message is forwarded
to the Internet.
Messages from the Internet are forwarded in the reverse order.
A message can be addressed to several recipients and a mixture of
WaveMail and Internet destinations is possible. Attachments can also be
sent/received to/from the Internet.

Depending on the setup of the WaveNet gateway, not all stations or users
might have the right for Internet access.
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10. Special Topics

10.1. POSTMASTER and Normal Users

10.1.1. POSTMASTER
The POSTMASTER is a user with special rights. The person who is in charge
of managing the WaveMail station should be the POSTMASTER. On single
user stations (no users defined) the only user is automatically the
POSTMASTER.

Special POSTMASTER rights:
- change the setup of the station (station setup and network setup)
- modify public addressbook
- redirect and delete messages from the message queue

Messages addressed to an unknown user on your WaveMail station will be
delivered to the POSTMASTER.

10.1.2. Normal Users
Several local users can use WaveMail in a certain location. Messages can be
addressed to an individual user. A user is identified by a username. Only the
addressed user will have access to his messages.

There are two possibilities for local users:
1. There is only a single PC running WaveMail.

Every user can use this single PC. He has to login on this PC before he
can read/write messages. After he has read/written his mail, he will logout
in order to prevent other users from reading his messages.

2. The PC running WaveMail is connected to a LAN.
WaveMail can be installed on other PCs on the LAN in a special 'Client'
mode. See chapter 'Installing WaveMail on a LAN. Local users can then
read/write messages from their PC. Modems and connections can only be
controlled from the PC with the modem(s).

10.1.3. Adding Users
Select Station Setup from the Setup menu to add users. WaveMail always
makes sure, that the first user added is the POSTMASTER.

10.2. Delivery / Non-Delivery Notifications
WaveMail creates Non-Delivery Notifications to inform the sender of a
message about delivery problems.

WaveMail can (optionally) create Delivery-Notifications to inform the sender
of a message about the delivery of a message. Check the 'Request delivery
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confirmation' checkbox while creating a message, if you want to receive a
positive confirmation when the message has been delivered to the
recipient(s). Note that negative notifications (e.g. unknown user, unknown
station) are created regardless of the state of the Request delivery
confirmation checkbox .

WaveMail displays received Notifications in the 'Received Messages' folder.
The status of the sent message in the OUT or SENT folder is also updated.
Select a message in the OUT or SENT folder and press the 'S' key to view
the status of a message (see section  'Show Status - Message Status' for
more information).

Notifications contain the Message-ID of the referenced message, a code and
some other information. When a notification is received, it is translated into
text and the subject of the referenced message is retrieved from the OUT or
SENT folder.

10.3. How WaveMail handles problem messages

10.3.1. Message addressed to an unknown station
If a message is addressed to an unknown station (or if there is a problem
with routing informations on one of the station on the route), WaveMail
returns a Non-Delivery notification to the sender, indicating which station was
unable to forward the message.

10.3.2. Message addressed to an unknown user on a known station
WaveMail delivers the message to the Postmaster of the destination station
and returns a Non-Delivery notification to the sender.

10.3.3. Message is not forwarded for more than 2 days
If a message was not forwarded for more than 2 days (on the senders station
or on a station between the sender and the destination), WaveMail returns a
Non-Delivery notification to the sender. However, the message remains in the
queue for 7 days. Therefore it is still possible that the msg is forwarded after
2 days.

10.3.4. Message too big to forward
If a message is bigger (after compression) than the maximum size specified
for a certain modem (and no alternative link is available), a non-delivery
notification will be returned.
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10.4. Installing WaveMail on a LAN
WaveMail can be used on a LAN. Users can then send and receive their
messages from their workstation. However, modem related functions (see
Connection and Special menu) are only available on the station that has the
modems connected.

On the PC where the modem(s) is/are connected, WaveMail is running in
Server-Mode (normal mode). On the other PCs WaveMail must be running in
Client-Mode (see WAVEMAIL.SI below).

10.4.1. Installation of WaveMail server
1. Install WaveMail on the PC with the modems (WaveMail server).
2. Use Station Setup from the Setup menu to add local users.
3. Select the Show Parameters function from the Setup. In section

------WaveMail Directory--------  you find the WaveMail  Directory
which you will need in step 4. below.

4. Share two directories:
  a) The WaveMail directory must be set for Sharing (with read access). The
      Share-Name must be WMSRV$ .
  b) The ...wavemail\user_trx\  directory must be set for Sharing (with
       read and write access). The Share-Name must be WMTRX$ .

example:
C:\programs\wavemail\            share as WMSRV$   (read)
C:\programs\wavemail\user_trx share as WMTRX$   (read + write)
(The Dollar-Sign at the end of the share-names makes these shared directories
'invisible' to Windows-Explorer on other PCs on the LAN).

WaveMail
(Server)

WaveMail
(Client)

WaveMail
(Client)

WaveMail
(Client)

LAN
Modem

Modem
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10.4.2. Installation of WaveMail client(s)
1. Install WaveMail on the users workstation (WaveMail client).
2. On the users workstation a file WAVEMAIL.SI must be created/edited.

This file must be in the same directory where WAVEMAIL.EXE is
(normally this is C:\programs\wavemail\program\ ). (A template file is
available as WAVEMAIL.SI$. You can copy WAVEMAIL.SI$ to
WAVEMAIL.SI and edit WAVEMAIL.SI.)

Edit WAVEMAIL.SI as follows:
[SPECIAL]
MODE=CLIENT
WMSERVER=computername

where computername must be replaced by the name of the PC where
WaveMail is running in Server-Mode (PC where the modems are
connected).

If WaveMail has to be installed on several client stations, the same
WAVEMAIL.SI  file can be copied to all stations.

10.4.3. Comments on LAN operation of WaveMail:
- The message database with a users messages is stored on the users

local drive.
- If the LAN connection is 'down' when WaveMail is started, then

WaveMail will operate in Offline-Mode. In this mode you have full access
to the messages that you have received earlier. You can also create new
messages. When you are  reconnected to the LAN and after restarting
WaveMail, the newly created messages will automatically be forwarded
to WaveMail server for sending.

- While connected to the LAN, WaveMail client stations will periodically
check whether there is new mail on the WaveMail server (every 30
seconds). If you have a bad LAN, WaveMail might 'freeze' while
checking for new messages. (If the line OfflineTXRX=1 is added to the
[SPECIAL] section of WAVEMAIL.SI, then WaveMail will only check for
new mail after Send+Receive button has been pressed).

- A WaveMail User should always login from the same PC because his
message database is stored on the local drive. (It is possible to tell WaveMail to
store the message database of every user on the WaveMail server station. However this
option has some disadvantages: no offline-operation possible, possibility of corruption of
message database is increased because all databse operations must be performed over the
LAN). If you really need the possibility to store the users message databases on the server,
you should contact Schuemperlin Engineering AG for details).

- The POSTMASTER can only perform login on the PC where WaveMail
runs in Server-mode.
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10.5. Swiss-PTC Modem specific topics

10.5.1. Public-Mode with Swiss-PTC Modems
As a default, SWISS-PTC modems operate in the so called Non-Public
Mode. In Non-Public Mode only modems with the same code can be
connected, thus having a closed network. If you want to establish a
connection with a remote station that uses the so called Public-Mode (same
as Amateur Pactor), the modem must be forced to Public-Mode.
If you are the calling station, you can add a '+' sign in front of the remote
stations callsign, e.g. +hb9cnm   (in Link Properties of Network Setup).
Whenever you attempt to establish a link with that particular station,
WaveMail will force the SWISS-PTC Modem to Public-Mode. The SWISS-
PTC Modem automatically returns to Non-Public mode after disconnect.
If you are the receiving station, you select the SWISS-PTC Modem on the
Modem Status Window of the main screen. Then you press CTRL+SHIFT+P
to force the modem to Public-Mode. The Public-Mode is indicated by [P] in
the status of the modem. If you press CTRL+SHIFT+N the modem will return
to Non-Public Mode.

10.5.2. Adjusting Audio Level on Swiss-PTC II Modems
The audio level of Swiss-PTC II modems is adjusted by a software command.
Select Station Setup from the Setup menu. Then select Properties for the
desired Swiss-PTC modem. Enter the following lines in the 'Initialization
string(s)'  list:
LOCK  0
FSKA  fff
PSKA  ppp

Replace fff and ppp with the values for Frequency-Shift-Keying and Phase-
Shift-Keying. Default values are FSKA 210 and PSKA 300. The LOCK 0 line
is needed to unlock the Swiss-PTC parameter locking mechanism.
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10.6. TAPI (Windows Modems)

10.6.1. Overview
TAPI (Telephony Application Programming Interface) is part of the Windows
operating systems. TAPI offers services to manage modems, to dial modem
connections and to answer modem connections.

When adding a normal telephone modem to the WaveMail configuration (
Setup - Station Setup - Add Modem), you have the choice between
'Telephone Modem' and 'Windows Modem (TAPI)'. After you choose
'Windows Modem (TAPI)' you can select the particular modem from the list of
installed modems.

Satellite phones with data capabilities like Inmarsat, Iridium or Thuraya can
also be used as 'Windows Modem (TAPI)' .

10.6.2. Advantages when using TAPI.
- TAPI supports modem sharing. If a 'Windows Modem (TAPI)'  type

modem is configured in WaveMail, the same modem can be used by a
second application (unless the modem is busy with a call). If you define a
modem as 'Telephone Modem' , then a second application cannot use
that modem while WaveMail is running.

- TAPI handles configuration and initialization of modems.
- TAPI supports the Windows dialing properties. If a phone number is

defined in the format
+country (area) number (e.g. +41 (52) 355 1666), then TAPI will
assemble the number to be dialled based on the location and dialing
properties defined in Windows (Start > Settings > Control Panel > Phone
and Modem Options).

- Modems which are connected via USB or infrared and that do not have a
driver for a Virtual COM port can be used with TAPI (if a modem is
configured as 'Telephone Modem' , then WaveMail needs a
corresponding COM port, real or virtual) .

10.6.3. Disadvantages when using TAPI.
- WaveMail does not have direct control over the modem and error

detection is limited.
- In some situations TAPI may have slow response times (e.g. when

aborting a connection while TAPI is dialing).
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11. Background information

11.1. Message Flow
After you create a message, WaveMail creates a compressed version of the
message (including attachments). WaveMail evaluates to which stations the
message should be sent (destination station(s) and forwarding station(s)) and
saves a copy of the compressed message in the queue(s) for the respective
station(s). The next time a link is established with a station, the messages in
the queue for that particular station are sent. This may include messages
which are not addressed to that station but which have to be forwarded by
that station.

When you select Send+Receive from the toolbar (or when a scheduled
connection is executing), WaveMail will perform the login operation, send
messages (smallest message first, biggest message last) and then receive
messages (again smallest first). All notifications are packed into one special
message for exchange between stations.

11.2. Message Routing
If WaveMail has to forward a message to STATIONX it will use the following
scheme to decide where to send the message next:
1. If a Specific Routing has been defined for STATIONX, then WaveMail

uses this routing information.
2. If a Link with station STATIONX is defined, then WaveMail will forward the

message over this link.
3. If neither 1 nor 2 are true, then WaveMail will forward the message to the

station defined in the Default Routing field.
4. If no Default Routing is defined, WaveMail will return a 'Address Unknown

Notification' to the originator of the message.

11.3. Automatic Link Establishment

11.3.1. Single channel radio links / telephone links
If WaveMail fails to establish a link on the scheduled time, it will automatically
retry after a preprogrammed interval ( 1 min for telephone modems, 10 min
for radio modems). After 3 unsuccessful attempts WaveMail gives up and will
try to establish the link on the next scheduled time. The case where the
channel, line or remote modem is busy is not counted as an attempt and
WaveMail will keep on trying with short intervals (60 seconds for telephone
modems, 120 sec for radio modems).
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11.3.2. Multi channels
If a Swiss-PTC modem is connected and 'Transceiver Control' is enabled,
WaveMail executes the following procedure for automatic link establishment:
At the scheduled time, WaveMail
- attempts to connect on the 1.Channel (depending on the time of day)

defined in the 'Channels' dialog of the 'Link properties'
- if the channel is busy or the connect attempt fails, WaveMail attempts to

connect on the 2. Channel (if defined)
- if the channel is busy or the connect attempt fails, WaveMail attempts to

connect on the 3. Channel (if defined)

After a preprogrammed time, WaveMail will retry on the 1.Channel and so on.
After 3 unsuccessful attempts (per channel) WaveMail gives up and will try to
establish the link on the next scheduled time. If a channel is busy at the time
of a connect attempt, this is not counted as attempt. WaveMail will continue
to check that channel (with a preprogrammed delay between attempts) until
the channel seems free. If a channel is busy, WaveMail will retry on that
channel after 2 minutes. After a failed connect attempt on a non-busy
channel, WaveMail will retry on that channel after 10 minutes.

For every channel the following action is taken:
1. Test whether transceiver is responding (for transceivers that

acknowledge commands).
2. Set channel
3. Wait a few seconds to let the Swiss-PTC check whether the channel is

busy.
4. Try to connect remote station

After a failed connect attempt or after disconnecting, WaveMail instructs the
transceiver to resume scanning.
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12. Tips and Tricks
How to delete messages older than a certain date
Select the desired folder. Sort messages by date (click on the header of the
Date column). Click on the first message to be deleted. Then press and hold
the Shift key and click on the last message to be deleted. Now press the
Delete key.

Importing existing text from a file into a new message
Text from a plain text file may be imported to a new message. In the New
Message window you can select Insert Text from File from the Edit menu or
you can use button  . Even the TO:, CC: and SUBJECT: headers of the
imported text file are copied to the respective fields of the new message
(headers must be in first 10 lines and no empty line may preceed these
headers).

Saving a draft version of a new message
When you are creating a new message, you might want to save it while the
message is not yet complete for sending.
In the 'New Message' window, select Save in Draft Folder from the Message
menu. You can then later select the saved message in the 'Draft Messages'
folder and open it to continue editing before sending the message.

The remote WaveMail station has not yet defined a link with my station, but I
want to send a message.
Exchanging messages is only possible, after a link has been defined on both
stations. However, you can send a message to the Postmaster of the remote
station even if the link to your station has not yet been defined on the remote
station. You could send a short message, asking the remote Postmaster to
add a Link to your station in his Network Setup.
1. Use Chat from the Connection menu to establish an online dialog with the

remote station.
2. After connection is established, press the Enter key to start e new line.
3. Enter the 4 letters ZCZC followed by the Enter key. This will start message

saving on the remote side.
4. Enter your text.
5. On a new line, enter the 4 letters NNNN followed by the Enter key. This will

end message saving on the remote side. The text you entered is delivered
to the postmaster on the remote station.

Automatic use of alternative links between two stations
If you have an HF-connection (Swiss-PTC) as well as an Inmarsat connection
between two stations, then you might wish that normally messages are
transmitted over HF (no airtime cost). However, because of varying
propagation conditions, HF might not always be available. Therefore you
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would prefer that messages are transferred over Inmarsat if it was not
possible to send/receive over HF.
You can easily do this by scheduling an automatic connection over Inmarsat
at regular times. As an example you could schedule a connection over
Inmarsat once early in the morning and once early in the evening. If all
messages have already been transferred by HF, then the Inmarsat
connection will be extremely short. However, if some messages were not
transferred over HF, then they will be transferred over Inmarsat.
Like this you take full advantage of both systems:

- save cost using HF if possible
- use the high availabilty of Inmarsat as backup

See section 'Network Setup' in chapter 'Advanced Setup', for details about
how to configure scheduled connections.

Copying the addressbook
The public addressbook is saved as WAVEMAIL.ADR at the same location
where WAVEMAIL.EXE is stored (normally c:\programs\wavemail\program\).
You can copy this file from one WaveMail station to another if you want to
have the same addressbook available.
You can also distribute WAVEMAIL.ADR by sending it as an attachment. If
you send the WAVEMAIL.ADR as an attachment in a message to the
postmaster of a WaveMail station, the recipient will have the option Save as
Addressbook when he double-clicks the WAVEMAIL.ADR attachment. This
will replace the public addressbook with the attached WAVEMAIL.ADR.

Using Thuraya
Setup of WaveMail for Thuraya:

- in STATION SETUP select ADD MODEM
- then select THURAYA
- select 19200 as baudrate

- make sure that the baudrate on the Thuraya phone is also 19200
(MENU - SETTINGS - Data Link Rate)

Using Iridium
Setup of WaveMail for Iridium:

- in STATION SETUP select ADD MODEM
- then select IRIDIUM
- select 19200 as baudrate

- make sure that the baudrate on the Iridium phone (MOTOROLA 9500) is
also 19200

Note: Tests have been made with WaveMail and a MOTOROLA 9500 Iridium phone. It
works but there is a little problem due to a strange behaviour of the MOTOROLA 9500:
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The Iridium phone gives the CONNECT message and sets DCD active as soon
as the line at the other end of the connection is ringing. Normally the CONNECT should
only come after the modem on the other side answers the call and the connection is
established. WaveMail starts to login when it receives the CONNECT message (and DCD
signal) but because this message comes too early (before the connection is really
established), WaveMail will make several attempts to login. In most cases this worked
fine, but if it takes long to establish the connection, WaveMail might give a timeout.

Packet Radio Modems - TX-Delay Parameter
WaveMail configures Packet-Radio modems with default parameters which
work fine for most applications. However there are situations where you
should add different parameters.

TX-Delay
In WaveMail the default value for the TX-Delay is T 25 (on most Packet-
Radio modems this value is multiplied by 10 and therefore corresponds to
250 msec). On some modems (e.g. TNC-3) the TX-Delay  is not multiplied
and therefore you should enter a higher value (e.g. T 250).
How to do that:
In WaveMail open Setup / Station Setup. Then click on Properties next to
the desired PACKET-RADIO modem. The 'Modem Properties' dialog will be
displayed. Click on Advanced Setup and enter the following line in the
'Initialization string(s)' box:

T  250

Packet Radio Modems - Optimize Throughput
If on a particular frequency only one Packet-Radio link is active at a time, you
can optimize the throughput by setting more aggressive parameters. If
several links are active at the same time then you should not change the
default parameters.

How to set aggressive parameters:
In WaveMail open Setup / Station Setup. Then click on Properties next to
the desired PACKET-RADIO modem. The 'Modem Properties' dialog will be
displayed. Click on Advanced Setup and enter the following lines in the
'Initialization string(s)' box:

P  128
@T2 20
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13. Troubleshooting

Connection with remote WaveMail station is possible, but messages are not
sent/received
Select Show Connect Log from the Special menu to view the 'Connect Log'
and check the column 'Result' of the 'Connect Log'.
If the result is 'login error', then the remote WaveMail station has not defined
a link with your station or it has defined a different password to protect this
link.
If the result is 'timeout', then WaveMail is probably not running on the remote
station.

Address unknown
If you get non-delivery notifications of the following type:
Address unknown  : address_y  (Station station_x has no routing information) 26.06.2000 22:07

then station_x (which may be your station or another station on the route)
does not know where to send the message. This may be because the
address is wrong or because the 'Network Setup' is not correct. If your station
does not have a direct link to the destination, then you should either define a
default routing station or a specific routing information for this address (see
'Network Setup').

The modem(s) are not properly configured
It is important to switch the modem(s) on before starting WaveMail, because
WaveMail initializes the modem(s) at startup.
You can also use the Reopen Modem function (select Modem Functions from
the Special menu) to completely reinitialize a modem.

Login / LAN operation
The following is only applicable if you use WaveMail with several users on a
LAN.
If you define local users on a WaveMail station, these users can either login
on the WaveMail-Server PC (where the modems are connected) or they can
login from another PC where WaveMail is installed for Client access over
LAN.

After a user has logged in from a WaveMail-Client, it is not possible for this
user to login directly on the WaveMail-Server PC. This is made in order to
prevent from losing messages. If you try to login directly on the WaveMail-
Server PC after having logged in from a WaveMail-Client, then you will
receive the message 'This account can only be accessed by CLIENT
WaveMail PCs! '.
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Problems with US-Robotics modem
Some types of US-Robotics modems need a special Initialization string. If
you define the modem as a 'Telephone Modem', then you have to enter this
string in the 'Modem Properties' dialog (this is not necessary for 'Windows
Modem (TAPI)' ).
 As a default, WaveMail ititializes 'Telephone Modems' at startup with AT&F
(set factory defaults). (In addition to that WaveMail sends the string
ATE0Q0X4V1&D2&C1S0=0 before dialing.)
For some US Robotics modems the string to set factory defaults is AT&F1.
You can set this in Setup / Station Setup / Modem Properties.  Activate
Advanced Setup and enter AT&F1 as 'Initialization string(s)'.
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APPENDIX A.  WaveMail Logfiles
WaveMail saves information about connections, sent messages and received
messages in logfiles.

There are 3 types of logfiles:
1. Connect Log
2. Transmit Log
3. Receive Log

A.1.  Connect Log

WaveMail writes a summary of every connection to a daily logfile.

General Format
- Connect Logs are saved in the directory LOG within the WaveMail-

directory structure.
- A new file is created for every day.
- Connect Log files have the extension .WCL  .
- The filename has the form ddmmyyyy.WCL (example 30092002.WCL for

30.Sep.2002).
- Every line contains the data for one connection.
- The fields of the Connect Log are separated by a TAB-stop (decimal 9)

Fields of a Connect Log Entry

Field Description Example
Date Date when connection was disconnected. 30.09.2002

Time Time when connection was disconnected. 14:38:45

Station-ID Station-ID of remote station KABUL

Modem Modem used SWISS-PTC

Result OK
  connection OK
remote busy
  remote modem was busy
manual disconnect
  message transfer interrupted by manual
disconnect
connect failed
  connect attempt failed
channel busy
  channel was busy
login error
  wrong Station-ID or Password
auto-disconnect
  WaveMail disconnected because of no
activity

OK
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protocol error
  error during message transfer
timeout
  no response from remote station
transceiver control error
  no response from transceiver
dial-up error
  dialup not possible (only TCP/IP)
modem busy
  modem (of this station) busy
failed
  connection failed, reason unknown
already logged in
  same station already logged in on other
modem

Origin/Channel - connection established by remote
X connection established by this

station
1,2,.. connection established by this

station on channel n (if transceiver
control enabled)

-

Minutes Duration of connection in minutes and
decimals of minutes (e.g. 2.75 is 2 minutes
and 45 seconds)

2.92

Bytes sent Number of bytes sent. This is the net byte
count of the compressed message(s).

8743

Bytes received Number of bytes received. This is the net
byte count of the compressed message(s).

15244

Messages sent Number of messages and notifications sent. 2

Messages
received

Number of messages and notifications
received.

3
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A.2.   Transmit Log

WaveMail writes a summary of every message sent to a daily logfile.

General Format
- Transmit Logs are saved in the directory LOG within the WaveMail-

directory structure.
- A new file is created for every day.
- Transmit Log files have the extension .WTL  .
- The filename has the form ddmmyyyy.WTL (example 30092002.WTL for

30.Sep.2002).
- Every line contains the data for one message.
- The fields of the Transmit Log are separated by a TAB-stop (decimal 9)

Fields of a Transmit Log Entry

Field Description Example
Date Date when message transfer was

completed.
30.09.2002

Time Time when message transfer was
completed.

14:38:45

Local Station-ID Station-ID of local station GENEVA

Remote Station-ID Station-ID of remote station KABUL

Direction Direction of message transfer
(always TX)

TX

Size of message Size of the message in bytes. This is
the net byte count of the compressed
message.

2763

Transfer duration Duration of transfer in minutes and
decimals of minutes (e.g. 2.75 is 2
minutes and 45 seconds)

1.93

Type of message MSG normal message
NOTIF notification
UNKNOWN unknown type

MSG

Modem Modem used. SWISS-PTC

Originator Sender of message. user@isp.com

Message-ID Message-ID of message.
(notifications from WaveMail to
Internet have no Message-ID and
therefore this field is then
‘NOTIFICATION’).

<76354@xy.com>

Note concerning Notifications:
Notifications from Internet to WaveMail are handled as normal messages.
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A.3.   Receive Log

WaveMail writes a summary of every received message to a daily logfile.

General Format
- Receive Logs are saved in the directory LOG within the WaveMail-

directory structure.
- A new file is created for every day.
- Receive Log files have the extension .WRL  .
- The filename has the form ddmmyyyy.WRL (example 30092002.WRL for

30.Sep.2002).
- Every line contains the data for one message.
- The fields of the Receive Log are separated by a TAB-stop (decimal 9)

Fields of a Receive Log Entry

Field Description Example
Date Date when message transfer was

completed.
30.09.2002

Time Time when message transfer was
completed.

14:38:45

Local Station-ID Station-ID of local station GENEVA

Remote Station-ID Station-ID of remote station KABUL

Direction Direction of message transfer
(always RX)

RX

Size of message Size of the message in bytes. This
is the net byte count of the
compressed message.

2763

Transfer duration Duration of transfer in minutes and
decimals of minutes (e.g. 2.75 is 2
minutes and 45 seconds)

1.93

Type of message MSG normal message
NOTIF notification
UNKNOWN unknown type

MSG

Modem Modem used. SWISS-PTC

Originator of
message

Sender of message. user1.kabul

Message-ID Message-ID of message.
(notifications from WaveMail to
Internet have no Message-ID and
therefore this field is then
‘NOTIFICATION’).

kabul.1234.56
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APPENDIX B. GLPLUS/RLPLUS Compatibility
It is recommended to equip the complete network with the WaveMail
software to take full advantage of all WaveMail features. However, if you wish
to use GLPLUS or RLPLUS software on some of your stations (e.g. during
the transition phase) you can do so.

Features and Limitations of GLPLUS/RLPLUS Compatibility

Features:
- Messages can be exchanged between WaveMail stations and

GLPLUS/RLPLUS stations.
- WaveMail stations and GLPLUS/RLPLUS stations can communicate in

Chat mode (online dialog).

Limitations:
- Attachments will NOT be sent to GLPLUS or RLPLUS stations.
- Forwarding capabilities are limited.

Special actions on WaveMail Station
Define a link to a GLPLUS/RLPLUS station:
Define a link to the GLPLUS or RLPLUS station as you do for WaveMail
stations (see Network Setup ). You must enter a special Station-ID of the
form 'GP:call'' where call must be set to the call sign of the remote SWISS-
PTC or Packet Radio modem
 example:  GP:hb9cnm

Address a message to a GLPLUS/RLPLUS station:
You can address messages to a GLPLUS or RLPLUS station using the
special  Station-ID as address ( GP:hb9cnm in the above example). The 'GP:'
tells WaveMail that the remote station is using GLPLUS or RLPLUS software.

Send+Receive messages (WaveMail is calling station):
You can use the Send + Receive button on the main screen to exchange
messages with GLPLUS or RLPLUS stations.

Special actions on GLPLUS/RLPLUS Station
Send+Receive messages (GLPLUS/RLPLUS is calling station):
The remote GLPLUS or RLPLUS station can use the ..EXCHANGE and
..READALL commands to exchange/read messages. Other
GLPLUS/RLPLUS commands (e.g. ..DIR) are not supported.

Chat mode:
A GLPLUS/RLPLUS station can enter  ..CHAT after connecting a WaveMail
station in order to open the chat window on the WaveMail station.
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